HP Deskjet 3520 e-All-in-One series
Contents

1 How Do I?...........................................................................................................................................................................3

2 Get to know the HP e-All-in-One
   Printer parts........................................................................................................................................................................5
   Control panel features..........................................................................................................................................................6
   Wireless settings...............................................................................................................................................................6
   Status lights........................................................................................................................................................................7
   Auto Power-Off ..................................................................................................................................................................8

3 Print
   Print photos.........................................................................................................................................................................9
   Print documents................................................................................................................................................................10
   Print Quick Forms...............................................................................................................................................................11
   Print envelopes.................................................................................................................................................................11
   Tips for print success........................................................................................................................................................11

4 ePrint from anywhere
   ePrint from anywhere........................................................................................................................................................15

5 Paper basics
   Recommended papers for printing.......................................................................................................................................17
   Load media.............................................................................................................................................................................18

6 Copy and scan
   Copy..................................................................................................................................................................................23
   Scan to a computer............................................................................................................................................................24
   Tips for copy success........................................................................................................................................................26
   Tips for scan success........................................................................................................................................................26

7 Work with cartridges
   Check the estimated ink levels..............................................................................................................................................29
   Order ink supplies............................................................................................................................................................29
   Replace the cartridges.......................................................................................................................................................30
   Cartridge warranty information.......................................................................................................................................32

8 Connectivity
   WiFi Protected Setup (WPS – requires WPS router).........................................................................................................33
   Traditional wireless connection (requires router).............................................................................................................34
   USB connection (non-network connection).......................................................................................................................34
   Change from a USB connection to a wireless network....................................................................................................34
   Connect wirelessly to the printer without a router...........................................................................................................35
   Connect a new printer........................................................................................................................................................35
   Change network settings....................................................................................................................................................35
   Tips for setting up and using a networked printer...........................................................................................................36
   Advanced printer management tools (for networked printers)..........................................................................................36

9 Solve a problem
   Improve print quality........................................................................................................................................................39
   Clear a paper jam.................................................................................................................................................................40
   Unable to print...................................................................................................................................................................42
   Networking.........................................................................................................................................................................47
   HP support.........................................................................................................................................................................47

10 Technical information
    Notice................................................................................................................................................................................51
    Cartridge chip information.............................................................................................................................................51
    Specifications.................................................................................................................................................................52
1 How Do I?

Learn how to use your HP e-All-in-One

- Printer parts
- Load media
- Copy
- Replace the cartridges
- Clear a paper jam
2 Get to know the HP e-All-in-One

- Printer parts
- Control panel features
- Wireless settings
- Status lights
- Auto Power-Off

Printer parts

- Front and top views of the HP e-All-in-One

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Display</td>
</tr>
<tr>
<td>2</td>
<td>Control panel</td>
</tr>
<tr>
<td>3</td>
<td>Paper tray</td>
</tr>
<tr>
<td>4</td>
<td>Paper tray extender (also referred to as the tray extender)</td>
</tr>
<tr>
<td>5</td>
<td>Glass</td>
</tr>
<tr>
<td>6</td>
<td>Lid-backing</td>
</tr>
<tr>
<td>7</td>
<td>Lid</td>
</tr>
<tr>
<td>8</td>
<td>Cartridge door</td>
</tr>
<tr>
<td>9</td>
<td>Cartridge access area</td>
</tr>
<tr>
<td>10</td>
<td>Cleanout door</td>
</tr>
</tbody>
</table>

- Rear view of the HP e-All-in-One
Control panel features

11 Rear USB port
12 Power connection

Control panel features

1 Back: Returns to the previous screen.
2 Cancel: Stops the current operation, restores default settings.
3 ATM/Selection button: Contextual button that changes depending on what is displayed on the screen.
4 Up button: Use this button to navigate menus and select number of copies.
5 Down button: Use this button to navigate menus and select number of copies.
6 OK: Confirms the current selecting.
7 Wireless status light and button: Blue light indicates wireless connection. Press the button to view wireless status and menu options. Press and hold down the button until light blinks to start Wi-Fi Protected Setup (WPS) push button mode.
8 ePrint button: Pressing button displays the Web Services Menu where you can view printer's email address and make ePrint settings.
9 On button: Turns the printer on or off.

Wireless settings

Press the Wireless button to view wireless status and menu options.

- If the printer has an active connection to a wireless network, the printer display will show Connected and the printer’s IP.
- If wireless is disabled (wireless radio off) and the wireless network is not available, the display screen shows Wireless Off.
- If wireless is enabled (wireless radio on) and you do not have a wireless connection, the display screen shows that it is either in the process of Connecting or Not Connected.
You can use the printer display to retrieve information about your wireless network, establish a wireless connection, and more.

<table>
<thead>
<tr>
<th>How do I?</th>
<th>Instructions</th>
</tr>
</thead>
</table>
| Print network configuration page. The network configuration page will display the network status, hostname, network name, and more. | 1. Press the Wireless button to access the Wireless Settings menu.  
2. Select Print Report, and then select Configuration Page.                                      |
| Print wireless network test report. The wireless network test report will display the diagnostics results for the status of the wireless network, wireless signal strength, detected networks, and more. | 1. Press the Wireless button to access the Wireless Settings menu.  
2. Select Print Report, and then select Test Report. |
| Restore network settings to default settings.                             | 1. Press the Wireless button to access the Wireless Settings menu.  
2. Select Restore to Default.  
3. Confirm selection to restore defaults.                                  |
| Turn wireless on or off.                                                 | 1. Press the Wireless button to access the Wireless Settings menu.  
2. Select Wireless.  
3. From the Wireless On/Off menu select On or Off.                        |
| Establish a Wi-Fi Protected Setup (WPS) connection.                      | WiFi Protected Setup (WPS – requires WPS router)                          |

**Status lights**

- Wireless status light
- On button light

**Wireless status light**

<table>
<thead>
<tr>
<th>Light behavior</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Wireless is off. Press Wireless button to access wireless menu on the printer display. Use wireless menu to enable wireless printing.</td>
</tr>
<tr>
<td>Slow blinking</td>
<td>Wireless is on but not connected to a network. If connection cannot be established, make sure printer is within range of wireless signal.</td>
</tr>
<tr>
<td>Fast blinking</td>
<td>Wireless error has occurred. Refer to messages on printer display.</td>
</tr>
<tr>
<td>On</td>
<td>Wireless connection has been established and you can print.</td>
</tr>
</tbody>
</table>

**On button light**

<table>
<thead>
<tr>
<th>Light behavior</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The printer is powered off.</td>
</tr>
<tr>
<td>Light behavior</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pulsing</td>
<td>Indicates the device is in sleep mode. The device automatically enters sleep mode after 5 minutes of inactivity.</td>
</tr>
<tr>
<td>Fast blinking</td>
<td>Error has occurred. Refer to messages on printer display.</td>
</tr>
<tr>
<td>Blinking steadily</td>
<td>The printer is printing or copying.</td>
</tr>
<tr>
<td>On</td>
<td>Printer is on and ready to print.</td>
</tr>
</tbody>
</table>

## Auto Power-Off

Auto Power-Off is automatically enabled by default when you turn on the printer. When Auto Power-Off is enabled, the printer automatically turns off after 2 hours of inactivity to help reduce energy use. Auto Power-Off is automatically disabled when the printer establishes a wireless or Ethernet (if supported) network connection. You can change the Auto Power-Off setting from the control panel. Once you change the setting, the printer maintains the setting. **Auto Power-Off turns the printer off completely, so you must use the power button to turn the printer back on.**

**To change Auto Power-Off setting**

1. From the Control Panel home screen, which displays Copy, Scan, and Quick Forms, select Settings.
   
   📝 **NOTE:** If you do not see the home screen, press the Back button until you can see it.
   
2. From the Settings menu on the printer display, select Preferences.
3. From the Preferences menu, select Auto-Off.
4. From the Auto-Off menu, select On or Off, and then press Continue to confirm the setting.

💡 **TIP:** If you are printing over a wireless or Ethernet connected network, Auto Power-Off should be disabled to ensure that print jobs do not get lost. Even when Auto Power-Off is disabled, the printer enters Sleep mode after 5 minutes of inactivity to help reduce energy use.
3 Print

Choose a print job to continue.

- Print photos
- Print documents
- Print envelopes
- Print Quick Forms

See [Tips for print success](#) for more information.

### Print photos

**To print a photo on photo paper**

1. Pull out the paper tray.
2. Remove all paper from the paper tray, and then load the photo paper with side to be printed on facing down.

   **NOTE:** If the photo paper you are using has perforated tabs, load photo paper so that tabs face outward.

   ![Photo Printing](image)

   See [Load media](#) for more information.

3. On the **File** menu in your software application, click **Print**.
4. Make sure the product is the selected printer.
5. Click the button that opens the **Properties** dialog box. Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer**, or **Preferences**.
6. Select the appropriate options.
   - On **Layout** tab select **Portrait** or **Landscape** orientation.
   - On **Paper/Quality** tab select the appropriate paper type and print quality from the **Media** drop-down list.
NOTE: For maximum dpi resolution, go to the Paper/Quality tab, select Photo Paper from the Media drop-down list and select Best for Quality Settings. Then click the Advanced button and select Maximum dpi from the Output Quality drop-down list. If you want to print Max DPI in grayscale, select High Quality Grayscale from the Print in Grayscale drop-down list, and then select Maximum dpi.

7. Click OK to return to the Properties dialog box.
8. Click OK, and then click Print or OK in the Print dialog box.

NOTE: Do not leave unused photo paper in the input tray. The paper might start to curl, which could reduce the quality of your printout. Photo paper should be flat before printing.

Print documents

To print from a software application
1. Make sure the paper tray is open.
2. Make sure you have paper loaded in the paper tray.

![Printer image]

See Load media for more information.
3. From your software application, click the Print button.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
6. Select the appropriate options.
   • On Layout tab select Portrait or Landscape orientation.
   • On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down list.
7. Click OK to close the Properties dialog box.
8. Click Print or OK to begin printing.

TIP: You can print your document on both sides of the paper, instead of just one side. On the Layout tab, select Flip on Long Edge or Flip on Short Edge from the Print on Both Sides drop-down menu. Click OK to print. After one page of the document has been printed, you will be prompted to wait for a few seconds. Then the printer will automatically load the paper back to print on the other side. You do not need to manually reload the paper or make any operations.

NOTE: If your printed documents are not aligned within the margins of the paper, make sure that you have selected the correct language and region. On the printer display, select Settings, and then select Preferences. Select your language, and then region from the options provided. The correct Language/Region settings ensure that the printer will have the appropriate default paper size settings.
Print Quick Forms

Use Quick Forms to print quick forms, calendar, and games.

Print Quick Forms
1. From the Control Panel home screen, select Quick Forms.

   TIP: If the Quick Forms option does not appear on the printer display menu, press the Back button until the Quick Forms option appears.

2. Press the Up and Down buttons to select My Quick Forms, Weekly Calendar, or Checklist. Then press OK.
3. After you have selected the item that you want to print, select the number of copies, and then press OK.

Print envelopes

You can load one or more envelopes into the input tray of the HP e-All-in-One. Do not use shiny or embossed envelopes or envelopes that have clasps or windows.

NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your word processing software. For best results, consider using a label for the return address on envelopes.

To print envelopes
1. Pull out the paper tray.
2. Place the envelopes in the center of the tray. The side to be printed on should face down. The flap should be on the left side.
3. Push the envelopes into the printer until they stop.
4. Slide the paper guides firmly against the edges of the envelopes.
5. On the File menu in your software application, click Print.
6. Make sure the product is the selected printer.
7. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
8. Select the appropriate options.
   • On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down list.
9. Click OK, and then click Print or OK in the Print dialog box.

Tips for print success

To successfully print, the HP cartridges should be functioning properly with sufficient ink, the paper should be loaded correctly, and the product should have the appropriate settings.
Ink tips
- Use genuine HP ink cartridges.
- Don’t open or uncap cartridges until you are ready to install them. Leaving caps on the cartridges reduces ink evaporation.
- Install the yellow, magenta, cyan, and black cartridges correctly. For more information, see Replace the cartridges.
- Check the estimated ink levels in the cartridges to make sure there is sufficient ink. For more information, see Check the estimated ink levels.
- For more information, see Improve print quality.
- If you are seeing ink smears on the back of the pages that you printed, use the Tools menu to clean.
  - From the home screen, which displays Copy, Scan, and Quick Forms, select Settings.
    - From the Settings menu, select Tools.
    - Scroll through the Tools menu until you see Clean Ink Smear, then press OK.
    - Follow the onscreen instructions.

Paper loading tips
- Load a stack of paper (not just one page). All of the paper in the stack should be the same size and type to avoid a paper jam.
- Load paper with side to be printed on facing down.
- Ensure that paper loaded in the paper tray lays flat and the edges are not bent or torn.
- Adjust the paper-width guides in the paper tray to fit snugly against all paper. Make sure the paper-width guide does not bend the paper in the paper tray.
- For more information, see Load media.

Printer settings tips
- On the Paper/Quality tab of the print driver, select the appropriate paper type and print quality from the Media drop-down list.
- Select the appropriate size from the Paper Size drop-down list on the Paper/Quality tab.
- Double-click the HP Deskjet 3520 series desktop icon to open the Printer Software. In the Printer Software, click Print and Scan and then click Set Preferences to access the print driver.
  - You can also access the Printer Software by clicking Start > All Programs > HP > HP Deskjet 3520 series
- You can print your document on both sides of the paper, instead of just one side.
  - On the Layout tab, select Flip on Long Edge or Flip on Short Edge from the Print on Both Sides drop-down menu.
  - Click OK to print.

After one page of the document has been printed, you will be prompted to wait for a few seconds. Then the printer will automatically load the paper back to print on the other side. You do not need to manually reload the paper or make any operations.
Notes

- Genuine HP ink cartridges are designed and tested with HP printers and papers to help you easily produce great results, time after time.

  **NOTE:** HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a result of using a non-HP supply will not be covered under warranty.
  
  If you believe you purchased genuine HP ink cartridges, go to:
  
  [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit)

- Ink level warnings and indicators provide estimates for planning purposes only.

  **NOTE:** When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not need to replace the cartridges until print quality becomes unacceptable.

- Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.

- You can print your document on both sides of the paper, instead of just one side.

  **NOTE:** Click the **Advanced** button on the **Paper/Quality** or **Layout** tab. From the **Pages to Print** drop-down list select **Print Odd Pages Only**. Click **OK** to print. After the odd numbered pages of the document have been printed, remove the document from the output tray. Reload the paper in the input tray with the blank side facing up. Return to the **Pages to Print** drop-down list and then select **Print Even Pages Only**. Click **OK** to print.

- Print using black ink only

  **NOTE:** If you want to print a black and white document using black ink only, click the **Advanced** button. From the **Print in Grayscale** drop-down menu select **Black Ink Only**, then click the **OK** button.

---

### Print using the maximum dpi

Use maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.

See technical specifications for the print resolution of the maximum dpi mode.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.

**To print in Maximum dpi mode**

1. Make sure you have photo paper loaded in the input tray.
2. On the **File** menu in your software application, click **Print**.
3. Make sure the product is the selected printer.
4. Click the button that opens the **Properties** dialog box. Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer**, or **Preferences**.
5. Click the **Paper/Quality** tab.
6. In the **Media** drop-down list, click **Photo Paper**. Then select **Best** under **Quality Settings**.

  **NOTE:** **Photo Paper, Best Quality** must be selected from the **Media** drop-down list on the **Paper/Quality** tab to enable printing in maximum DPI.

7. Click the **Advanced** button.
8. In the **Printer Features** area, select **Maximum dpi** from the **Output Quality** drop-down list.
9. Click **OK** to close the advanced options.
10. Confirm **Orientation** on **Layout** tab, then click **OK** to print.
ePrint from anywhere

Before you can use ePrint, make sure that:

- The printer is connected to an active network providing Internet access.
- Web Services is turned on. If not, you will be prompted to turn it on.

To print a document using ePrint

1. Enable Web Services.
   a. From the printer control panel, press the ePrint button.
   b. Accept the Terms of Use, and then follow the onscreen instructions to enable Web Services.
   c. Print the ePrint information page, and then follow the instructions on the page to sign up for an ePrint account.

2. Find the ePrint email address of the printer.
   ▲ From the printer control panel, press the ePrint button. Then you will see the printer's email address on the display. You can also select Print Info to print the email address or registration url.

3. Email your document to the printer for printing.
   a. Create a new email and attach the document to print.
   b. Send the email to the printer email address.
   The printer prints the attached document.

NOTE: 1 The email will be printed once it is received. As with any email, there is no guarantee when or whether it will be received. You can check the print status on ePrintCenter (www.eprintcenter.com).

NOTE: 2 Documents printed using ePrint may appear different from the original, for example, in the style, formatting, and text flow. For documents (such as legal documents) that require better print quality, it is recommended that you print from the software application on your computer, where you can have more control over how the printout will look.

Click here to go online for more information.
5 Paper basics

- Recommended papers for printing
- Load media

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

ColorLok
- HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

HP Advanced Photo Paper
- This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x 7 inch), and two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
- Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in semi-gloss finish in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch) (with or without tabs). For longer-lasting photos, it is acid-free.

HP Brochure Paper or HP Superior Inkjet Paper
- These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

HP Premium Presentation Paper or HP Professional Paper
- These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters. They are heavyweight for an impressive look and feel.
HP Bright White Inkjet Paper
• HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

HP Printing Paper
• HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial than documents printed on standard multipurpose or copy paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

HP Office Paper
• HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

HP Iron-On Transfers
• HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom T-shirts from your digital photos.

HP Premium Inkjet Transparency Film
• HP Premium Inkjet Transparency Film make your color presentations vivid and even more impressive. This film is easy to use and handle and dries quickly without smudging.

HP Photo Value Pack
• HP Photo Value Packs conveniently package original HP cartridges and HP Advanced Photo Paper to save you time and take the guesswork out of printing affordable professional photos with your HP e-All-in-One. Original HP inks and HP Advanced Photo Paper have been designed to work together so your photos are long lasting and vivid, print after print. Great for printing out an entire vacation’s worth of photos or multiple prints to share.

Load media
▲ Select a paper size to continue.

Load full-size paper
a. Lower the paper tray.
   Lower the paper tray and pull out the tray extender.

b. Slide paper-width guides outward.
   Slide paper-width guides outward.
c. Load paper.
   Insert stack of paper into paper tray with short edge forward and print side down.

   Slide stack of paper until it stops.
   Adjust paper-width guides so they fit against both sides of the stack of paper.

Load small-size paper
a. Slide the paper tray out.
   Slide the paper tray and pull out the tray extender.

   Slide paper-width guides outward.
   Slide paper-width guides outward.
c. Load paper.
   Insert stack of photo paper with short edge forward and print side down.

Slide stack of paper forward until it stops.

**NOTE:** If the photo paper you are using has perforated tabs, load photo paper so that tabs face outward.

Adjust paper-width guides so they fit against both sides of the stack of paper.
Slide paper tray in.

**Load envelopes**

a. Lower the paper tray
   Lower the output tray and pull out the tray extender.

b. Slide paper-width guides outward.
   Slide paper-width guide outward.
Remove all paper from the main input tray.

c. Load envelopes.
   Insert one or more envelopes in center of the input tray. The side to be printed on should face down. The flap should be on the left side and facing up.

Slide stack of envelopes down until it stops.
Slide paper-width guide to the right against stack of envelopes until it stops.
6 Copy and scan

- Copy
- Scan to a computer
- Tips for copy success
- Tips for scan success

Copy

▲ The Copy menu on the printer display allows you to easily select number of copies and color or black and white for copying on plain paper. You can also easily access advanced settings, such as changing the paper type and size, adjusting the darkness of the copy, and resizing the copy.

Click a copy type to continue.

Easy Copy

a. Load paper.
   Load full-size paper in the paper tray.

b. Load original.
   Lift lid on product.

Load original print side down on right front corner of glass.
Close lid.

c. Select Copy from the printer display menu to access the copy menu.

If you do not see Copy on the printer display, press the Back button until you see Copy.

From the Copy menu, select Copies to increase or decrease the number of copies. Then press OK to confirm.

Select Start Black Copy or Start Color Copy to copy onto A4 or 8.5” x 11” plain paper.

More copy features

▲ While in the Copy menu, press the Up and Down buttons to select among settings.

- **Paper Size**: Selects paper size and paper type. A plain paper setting will print in plain paper normal print quality. A photo paper setting will print in photo paper best quality.
- **Resize**: **Actual size** makes a copy that is the same as the size of the original, but the margins of the copied image may be clipped. **Resize to fit** makes a copy that is centered with a white border around the edges. The resized image is either enlarged or reduced to fit the size of the selected output paper.
- **Custom Size** allows you to increase the size of the image by selecting values greater than 100% or reduce the image size by selecting values less than 100%.
- **Lighter / Darker**: Adjusts the copy settings to make copies lighter or darker.

**NOTE**: After two minutes of inactivity the copy options will automatically return to the default settings of plain paper A4 or 8.5” x 11” (depending on region).

Scan to a computer

You can initiate a scan from the control panel of the printer or from your computer. Scan from the control panel if you want to quickly scan one page to an image file. Scan from your computer if you want to scan multiple pages into one file, define the file format of the scan, or make adjustments to the scanned image.

Prepare the scan

▲ To prepare the scan:

a. Load original.

Lift lid on product.

Load original print side down on right front corner of glass.
Scan from the printer control panel

1. Select **Scan** from the printer display menu. If you do not see **Scan** on the printer display press the **Back** button until you do.

2. Select **Scan to Computer**.

3. Select the computer that you want to scan to from the printer display.
   - If you do not see your computer listed on the printer display make sure that your computer is connected to the printer either wirelessly or through a USB cable.
   - If you have a wireless connection and you have confirmed that the connection is working, you will need to enable wireless scanning in the software.
   a. Double-click the **HP Deskjet 3520 series** desktop icon to open the Printer Software.

   **NOTE:** You can also access the Printer Software by clicking **Start > All Programs > HP > HP Deskjet 3520 series > HP Deskjet 3520 series**

   b. Click the **Print and Scan** icon.

   c. Click **Manage Scan to Computer**.

   **NOTE:** You can choose to keep the **Scan to Computer** option always active. If this feature is always active, you will be able to select the **Scan** option from the printer display to scan to your wirelessly connected computers that are in use. If this feature is not always active, then you will need to first activate the **Scan to Computer** option in the Printer Software before you scan. This only affects scanning from the printer control panel. Whether **Scan to Computer** is active or not, you will always be able to make a scan from your computer.

4. Locate the scanned image on your computer. After the scan is saved, a Windows Explorer window will open in the directory where the scan was saved.
Scan from your computer

1. Open the HP Scan application. Click Start > All Programs > HP > HP Deskjet 3520 series > HP Deskjet 3520 series > HP Scan.
2. Select the type of scan that you want from the shortcut menu and then click Scan.

\[\text{NOTE: If Show scan preview is selected, you will be able to make adjustments to the scanned image in the preview screen.}\]

3. Select Save if you want to keep the application open for another scan, or select Done to exit the application.
4. After the scan is saved, a Windows Explorer window will open in the directory where the scan was saved.

\[\text{NOTE: There is a limited number of computers that can have the scan function activated at the same time. Access the Scan menu from the printer home screen and you will see the computers that are currently available for scanning.}\]

Tips for copy success

- Load your original print side down on the right front corner of the glass.

- To increase or decrease the contrast of your printed output, select Copy from the printer display and then select Lighter / Darker to adjust the brightness.

- To select the paper size and paper type of the printed output, select Copy from the printer display. From the Copy menu select Paper Size to choose plain or photo paper and photo paper size.

- To resize the image, select Copy from the printer display, and then select Resize.

Tips for scan success

- Load your original print side down on the right front corner of the glass.
• Clean the scanner glass and make sure that there are no foreign materials adhering to it.
• If you have a wireless connection and you have confirmed that the connection is working, you will need to enable wireless scanning in the software to scan from the printer display. Open the Printer Software to select Print and Scan and then select Manage Scan to Computer.
• After you select Scan from the printer display, choose the computer that you want to scan to from the list of printers on the printer display.
• If you have a wireless connection from your printer to your computer, and you want to always be able to quickly scan to your connected computer, choose to have Scan to Computer always active.
• If you want to scan a document with several pages into one file instead of multiple files, start the scan with the Printer Software instead of selecting Scan from the control panel.

Click here to go online for more information.
7 Work with cartridges

- Check the estimated ink levels
- Order ink supplies
- Replace the cartridges
- Cartridge warranty information

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink supply level shows an estimate of the amount of ink remaining in the cartridges.

To check the ink levels from the control panel

▲ From the Control Panel home screen, which displays Copy, Scan, and Quick Forms, select Ink Levels. Then the printer displays the current ink levels.

**NOTE:** If you do not see the home screen, press the Back button until you can see it.

To check the ink levels from the Printer Software

1. Double-click the HP Deskjet 3520 series desktop icon to open the Printer Software.

   **NOTE:** You can also access the Printer Software by clicking Start > All Programs > HP > HP Deskjet 3520 series > HP Deskjet 3520 series

2. In the Printer Software, click Estimated Ink Levels.

   **NOTE:** If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.

   **NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not have to replace the cartridges until the print quality is unacceptable.

   **NOTE:** Ink from the cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it is used. For more information, see www.hp.com/go/inkusage.

Order ink supplies

Before ordering cartridges, locate the correct cartridge number.

Locate the cartridge number on the printer

▲ The cartridge number is located inside the cartridge door.
Chapter 7

Locate the cartridge number in the Printer Software
1. Double-click the HP Deskjet 3520 series desktop icon to open the Printer Software.

   **NOTE:** You can also access the Printer Software by clicking Start > All Programs > HP > HP Deskjet 3520 series

2. In the Printer Software, click Shop, and then click Shop For Supplies Online. The correct cartridge number will be automatically displayed when you use this link.

   To order genuine HP supplies for the HP e-All-in-One, go to [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies). If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

   **NOTE:** Ordering cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.

Related topics
- Choose the right cartridges

Choose the right cartridges

HP recommends that you use genuine HP cartridges. Genuine HP cartridges are designed and tested with HP printers to help you easily produce great results, time after time.

Related topics
- Order ink supplies

Replace the cartridges

To replace the cartridges
1. Check that power is on.
2. Remove cartridge.
   a. Open cartridge access door.

   ![Open cartridge access door]  
   Wait for print carriage to move to right side of product.
   b. Press tab on cartridge, then remove it from slot.
3. Insert new cartridge.
   a. Remove cartridge from packaging.
   b. Twist orange cap to snap it off. A forceful twist may be required to remove cap.
   c. Match color icons, then slide cartridge into slot until it clicks into place.
d. Close cartridge door.

Cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement for the printer, see the printed documentation that came with the product.
8 Connectivity

- WiFi Protected Setup (WPS – requires WPS router)
- Traditional wireless connection (requires router)
- USB connection (non-network connection)
- Change from a USB connection to a wireless network
- Connect wirelessly to the printer without a router
- Connect a new printer
- Change network settings
- Tips for setting up and using a networked printer
- Advanced printer management tools (for networked printers)

WiFi Protected Setup (WPS – requires WPS router)

To connect the HP e-All-in-One to a wireless network using WiFi Protected Setup (WPS), you will need the following:

- A wireless 802.11b/g/n network that includes a WPS-enabled wireless router or access point.
- A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The computer must be connected to the wireless network that you intend to install the HP e-All-in-One on.

**NOTE:** If you have a Wi-Fi Protected Setup (WPS) router with a WPS push button, follow the Push Button method. If you are not certain your router has a push button, follow the Wireless Settings Menu method.

**Push Button (PBC) method**

1. Press the WiFi Protected Setup (WPS) button on your router.
2. Press and hold the **Wireless** button on the printer until the wireless light starts blinking. Press and hold for 3 seconds to start WPS push button mode.

**NOTE:** The product begins a timer for approximately two minutes in which the corresponding button on the networking device needs to be pressed.

**Wireless Settings Menu method**

1. Press the **Wireless** button on the printer to display the Wireless menu. If the printer is printing, in an error state, or performing a critical task, wait until the task has been completed or the error cleared before pressing the **Wireless** button.
2. Select **Settings** from the printer display.
3. Select **Wi-Fi Protected Setup** from the printer display.
4. If you have a Wi-Fi Protected Setup (WPS) router with a WPS push button, select **Push Button Setup**, and then follow the onscreen instructions. If your router does not have a push button or you are not certain if your router has a push button, select **PIN Setup**, and then follow the onscreen instructions.

**NOTE:** The product begins a timer for approximately two minutes during which the corresponding button on the networking device needs to be pressed or the router PIN needs to be entered on the router’s configuration page.
Traditional wireless connection (requires router)

To connect the HP e-All-in-One to an integrated wireless LAN 802.11 network, you will need the following:

A wireless 802.11b/g/n network that includes a wireless router or access point.

NOTE: The HP e-All-in-One only supports connections using 2.4GHz.

A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The computer must be connected to the wireless network that you intend to install the HP e-All-in-One on.

Network name (SSID).

WEP key or WPA Passphrase (if needed).

To connect the product
1. Insert the product Software CD in the computer CD-ROM drive.
2. Follow the instructions on the screen.
   - When you are prompted, connect the product to the computer using the USB setup cable included in the box.
   - Follow the onscreen prompts to enter your wireless network settings. The product will attempt to connect to the network. If the connection fails, follow the prompts to correct the problem, and then try again.
3. When the setup is finished, you will be prompted to disconnect the USB cable and test the wireless network connection. Once the product connects successfully to the network, install the software on each computer that will use the product over the network.

USB connection (non-network connection)

The HP e-All-in-One supports a rear USB 2.0 High Speed port for connection to a computer.

NOTE: Web services will not be available with a USB direct connection.

To connect the product with the USB cable
- Refer to the setup instructions that came with your product for information on connecting to a computer with a USB cable.

NOTE: Do not connect the USB cable to the product until you are prompted to do so.

If the printer software has been installed, the printer will operate as a plug and play device. If the software has not been installed, insert the CD that came with the device and follow the onscreen instructions.

Change from a USB connection to a wireless network

If you first setup your printer and installed the software with a USB cable, directly connecting the printer to your computer, you can easily change to a wireless network connection. You will need a wireless 802.11b/g/n network that includes a wireless router or access point.

NOTE: The HP e-All-in-One only supports connections using 2.4GHz.

Before changing from a USB connection to a wireless network, make sure that:
- The printer is connected to your computer with the USB cable until you are prompted to disconnect the cable.
- The computer is connected to the wireless network that you intend to install the printer on.

Change from a USB connection to a wireless network
1. From the computer’s start menu select All Programs or Programs, and then select HP.
2. Select HP Deskjet 3520 series.
3. Select Printer Setup and Software.
4. Select Convert a USB connected printer to wireless. Follow the onscreen instructions.
Connect wirelessly to the printer without a router

HP Wireless Direct allows your Wi-Fi devices such as computers, smart phones, and tablets, to connect to your printer directly through Wi-Fi, using the process you currently use to connect your Wi-Fi device to new wireless networks and hotspots. With Wireless Direct, you can print directly to the printer wirelessly, without a wireless router, from your Wi-Fi enabled devices.

To get started with Wireless Direct print
1. To use Wireless Direct, you need to turn on Wireless Direct from the control panel, and get the Wireless Direct name and password if you have Wireless Direct security on:
   a. From the home screen, press the Wireless button and then select Settings.
   b. If the display shows that Wireless Direct is Off, select Wireless Direct and then select On (No Security) or On (With Security).

   **NOTE:** If you turn on security, only users with the password will be able to connect wirelessly to the printer. If you turn off security, anyone with a Wi-Fi device within Wi-Fi range of the printer will be able to connect to the printer.

   c. Select Display Name to display the Wireless Direct name.
   d. Select Display Password to display the Wireless Direct password if you have the Wireless Direct security on.

2. From your wireless computer or mobile device, turn wireless on, search for and connect to the Wireless Direct name, for example: HP-print-BF-Deskjet 3520. If you have Wireless Direct security on, enter the Wireless Direct password when prompted. Then print as you normally do from your computer or mobile device.

   **NOTE:** 1 Wireless Direct connection provides no Internet access.

   **NOTE:** 2 The Wireless Direct connection is available even if the printer is also connected to a wireless home network.

   **NOTE:** 3 All functions that are available on your wireless home network, such as printing, scanning and printer maintenance, are also available when a computer, with the printer software installed, is connected to the printer through Wireless Direct. Some functions may not be supported if the printer has a simultaneous wireless connection to your home network and Wireless Direct.

Connect a new printer

If you have not connected the printer to your computer, or you want to connect another new printer of the same model to your computer, you can use the Connect a new printer function to set up the connection.

To connect a new printer
1. From the computer’s start menu select All Programs or Programs, and then select HP.
2. Select HP Deskjet 3520 series.
3. Select Printer Setup and Software.
4. Select Connect a new printer. Follow the onscreen instructions.

Change network settings

To change network settings
1. From the computer’s start menu select All Programs or Programs, and then select HP.
2. Select HP Deskjet 3520 series.
3. Select Printer Setup and Software.
4. Select Connect a new printer. Follow the onscreen instructions.
Tips for setting up and using a networked printer

Use the following tips to set up and use a networked printer:

- When setting up the wireless networked printer, make sure your wireless router or access point is powered on. The printer searches for wireless routers, then lists the detected network names on the computer.
- If your computer is connected to a Virtual Private Network (VPN), you need to disconnect from the VPN before you can access any other device on your network, including the printer.
- Learn how to find your network security settings. Click here to go online for more information.
- Learn about the Network Diagnostic Utility and other troubleshooting tips. Click here to go online for more information.
- Learn how to change from a USB to wireless connection. Click here to go online for more information.
- Learn how to work with your firewall and anti-virus programs during printer setup. Click here to go online for more information.

Advanced printer management tools (for networked printers)

When the printer is connected to a network, you can use the embedded Web server to view status information, change settings, and manage the printer from your computer.

**NOTE:** To view or change some settings, you might need a password.

You can open and use the embedded Web server without being connected to the Internet. However, some features are not available.

- To open the embedded Web server
- About cookies

To open the embedded Web server

**NOTE:** The printer must be on a network and must have an IP address. The IP address for the printer can be found by pressing the Wireless button or by printing a network configuration page.

In a supported Web browser on your computer, type the IP address or hostname that has been assigned to the printer.

For example, if the IP address is 192.168.0.12, type the following address into a Web browser such as Internet Explorer: http://192.168.0.12.

About cookies

The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are browsing. These files let the EWS recognize your computer the next time you visit. For example, if you have configured the EWS language, a cookie helps remember which language you have selected so that the next time you access the EWS, the pages are displayed in that language. Though some cookies are cleared at the end of each session (such as the cookie that stores the selected language), others (such as the cookie that stores customer-specific preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to remove unwanted cookies.

**NOTE:** Depending on your printer, if you disable cookies, you also disable one or more of the following features:
• Starting where you left the application (especially useful when using setup wizards)
• Remembering the EWS browser language setting
• Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see the documentation available with your Web browser.
9 Solve a problem

This section contains the following topics:

- Improve print quality
- Clear a paper jam
- Unable to print
- Networking
- HP support

## Improve print quality

1. Make sure you are using genuine HP cartridges.
2. Check the print properties to make sure you have selected the appropriate paper type and print quality from the Media drop-down list. In the Printer Software, click Print and Scan and then click Set Preferences to access the print properties.
3. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see Check the estimated ink levels. If the print cartridges are low on ink consider replacing them.
4. Align the printer cartridges

   **To align the cartridges from the Printer Software**

   ✓ **NOTE:** Aligning the cartridges ensures high-quality output. The HP All-in-One prompts you to align the cartridges every time you install a new cartridge. If you remove and reinstall the same print cartridge, the HP All-in-One will not prompt you to align the print cartridges. The HP All-in-One remembers the alignment values for that print cartridge, so you do not need to realign the print cartridges.

   a. Load letter or A4 unused plain white paper into the input tray.
   b. In the Printer Software, click Print and Scan and then click Maintain Your Printer to access the Printer Toolbox.
   c. The Printer Toolbox appears.
   d. Click Align Printheadson the Device Services tab. The product prints an alignment sheet.
   e. Load the cartridge alignment sheet print side down on the right front corner of the glass.
   f. Follow the instructions on the printer display to align the cartridges. Recycle or discard the cartridge alignment sheet.
5. Print a diagnostics page if the cartridges are not low on ink.

   **To print a diagnostics page**

   a. Load letter or A4 unused plain white paper into the input tray.
   b. In the Printer Software, click Print and Scan and then click Maintain Your Printer to access the Printer Toolbox.
   c. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page. Review the blue, magenta, yellow, and black boxes on the diagnostics page. If you are seeing streaks in the color and black boxes, or no ink in portions of the boxes, then automatically clean the cartridges.
6. Clean the print cartridges automatically, if the diagnostic page shows steaks or missing portions of the color and black boxes.

To clean the printhead automatically
   a. Load letter or A4 unused plain white paper into the input tray.
   b. In the Printer Software, click **Print and Scan** and then click **Maintain Your Printer** to access the **Printer Toolbox**.
   c. Click **Clean Printheads** on the **Device Services** tab. Follow the onscreen instructions.

If the above solutions do not resolve the problem, [click here for more online troubleshooting](#).

**Clear a paper jam**

If you see paper jammed and can access from the exterior of the printer, pull out jammed paper and then press **OK**. If you cannot see or access paper from the exterior, open cartridge access door to locate jam.

**Open cartridge access door to locate the jam.**

1. If the paper jam is located in the cartridge access area, pull on the paper to remove jammed paper.

**NOTE:** When you remove the paper make sure that you do not touch white encoder strip attached to the carriage.
2. If the paper jam is located towards the back of the printer, open the cleanout door to access.
   
   a. Open cleanout door.
   b. Remove jammed paper.
   c. Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

3. If the paper cannot be reached by opening the cartridge access door, close the cartridge access door.
   
   a. Remove all paper or media from the paper tray.
   b. Rotate printer until it rests on its left side.
   c. Slide out the paper tray, then remove jammed paper from inside the printer.
   d. Slide paper tray back into place.
   e. Rotate printer so it stands on its base, then load paper.

Press the OK button on the control panel to continue the current job.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Prevent paper jams
- Do not overfill the input tray.
- Remove printed papers from the output tray frequently.
- Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
- Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input tray must be the same size and type.
- Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide does not bend the paper in the input tray.
- Do not force paper too far forward in the input tray.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
Unable to print

If you’re having trouble printing, you can download the HP Printing Diagnostic Utility, which can troubleshoot this issue for you automatically. To get the utility, click the appropriate link:

NOTE: The HP Printing Diagnostic Utility may not be available in all languages.

Take me to the HP Printing Diagnostic Utility download page (32-bit Windows).
Take me to the HP Printing Diagnostic Utility download page (64-bit Windows).

Resolve print issues

NOTE: Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to print, try the following in order:

1. Check for error messages and resolve.
2. Disconnect and reconnect the USB cable.
3. Verify that the product is not paused or offline.

   To verify that the product is not paused or offline
   a. Depending upon your operating system, do one of the following:
      - Windows 7: From the Windows Start menu, click Devices and Printers.
      - Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
      - Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.
   b. Either double-click the icon for your product or right-click the icon for your product and select See what’s printing to open the print queue.
   c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer Offline.
   d. If you made any changes, try to print again.
4. Verify that the product is set as the default printer.

   To verify that the product is set as the default printer
   a. Depending upon your operating system, do one of the following:
      - Windows 7: From the Windows Start menu, click Devices and Printers.
      - Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
      - Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.
   b. Make sure the correct product is set as the default printer.
      The default printer has a check mark in a black or green circle next to it.
   c. If the wrong product is set as the default printer, right-click the correct product and select Set as Default Printer.
   d. Try using your product again.
5. Restart the print spooler.

   To restart the print spooler
   a. Depending upon your operating system, do one of the following:
      - Windows 7
         • From the Windows Start menu, click Control Panel, System and Security, and then Administrative Tools.
         • Double-click Services.
         • Right-click the Print Spooler, and then click Properties.
On the General tab, next to Startup type, make sure that Automatic is selected.
If the service is not already running, under Service status, click Start, and then click OK.

**Windows Vista**
- From the Windows Start menu, click Control Panel, System and Maintenance, Administrative Tools.
- Double-click Services.
- Right-click the Print Spooler service, and then click Properties.
- On the General tab, next to Startup type, make sure that Automatic is selected.
- If the service is not already running, under Service status, click Start, and then click OK.

**Windows XP**
- From the Windows Start menu, right click My Computer.
- Click Manage, and then click Services and Applications.
- Double-click Services, and then select Print Spooler.
- Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.

c. If the wrong product is set as the default printer, right-click the correct product and select Set as Default Printer.
d. Try using your product again.

6. Restart the computer.
7. Clear the print queue.

To clear the print queue

a. Depending upon your operating system, do one of the following:
   - **Windows 7**: From the Windows Start menu, click Devices and Printers.
   - **Windows Vista**: From the Windows Start menu, click Control Panel, and then click Printers.
   - **Windows XP**: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your product to open the print queue.
c. On the Printer menu, click Cancel All Documents or Purge Print Document, and then click Yes to confirm.
d. If there are still documents in the queue, restart the computer and try printing again after the computer has restarted.
e. Check the print queue again to make sure it is clear, and then try to print again.
   If the print queue is not clear, or if it is clear but jobs are still failing to print, proceed to the next solution.

If the above solutions do not resolve the problem, [click here for more online troubleshooting.](#)

---

**Clear the print carriage**

Remove any objects, such as paper, that are blocking the print carriage.

**NOTE:** Do not use any tools or other devices to remove jammed paper. Always use caution when removing jammed paper from inside the product.

[Click here to go online for more information.](#)
Prepare paper tray

Open paper tray
▲ Paper tray must be open to begin printing.

Prepare printer

If you are not satisfied with the print quality, clean the cartridges automatically from the control panel.

Clean the cartridges automatically.
1. From the home screen, which displays Copy, Scan, and Quick Forms, select Settings.
   
   NOTE: If you do not see the home screen, press the Back button until you can see it.

2. From the Settings menu, select Tools.
3. From the Tools menu, select Clean Printhead.
4. Follow the onscreen instructions.

To maintain the cartridges, use the printer's Auto Power-Off feature to manage the printer's power use.

For more information, see Auto Power-Off

Printer failure

Resolve printer failure.
▲ If you have already turned the printer off and then on, and this does not solve your problem, contact HP support.

Please contact HP support for help.

Printhead failure

The printhead in this product has failed.

Please contact HP support for help.
Manual duplex

Automatic two-sided printing is not supported for certain media types. When you cannot use automatic two-sided printing due to media type conflict, you can print on both sides of the paper using manual duplex.

**To manually print on both sides**

1. On the File menu in your software application, click Print.
2. In the printer driver, select Odd pages from the Print drop-down menu. Click OK to print.
3. After the odd numbered pages of the document have been printed, remove the printed pages from the output tray and reload them in the input tray with the blank side facing down.
4. Return to the Print drop-down menu and then select Even pages. Click OK to print.

Ink cartridge problem

First try removing and reinserting the cartridges. If this does not work, clean the cartridge contacts. If your problem is still not resolved, Replace the cartridges.

**Clean the ink cartridge contacts**

⚠️ **CAUTION:** The cleaning procedure should take only a few minutes. Make sure that the ink cartridges are reinstalled in the product as soon as possible. It is not recommended to leave the ink cartridges outside of the product longer than 30 minutes. This could result in damage to both the printhead and the ink cartridges.

1. Check that power is on.
2. Open cartridge access door.

Wait for print carriage to move to right side of product.
3. Press tab on cartridge indicated in the error message, then remove it from slot.
4. Hold the ink cartridge by its sides with the bottom pointing up and locate the electrical contacts on the ink cartridge. The electrical contacts are four small rectangles of copper or gold-colored metal on the bottom of the ink cartridge.

5. Wipe only the contacts with a dry swab or lint-free cloth.

⚠️ **CAUTION:** Be careful to touch only the contacts, and do not smear any of the ink or other debris elsewhere on the cartridge.

6. On the inside of the product, locate the contacts in the printhead. The contacts look like a set of four copper or gold-colored pins positioned to meet the contacts on the ink cartridge.

7. Use a dry swab or lint-free cloth to wipe the contacts.
8. Reinstall the ink cartridge.
9. Close the access door, and check if the error message has gone away.
10. If you still receive the error message, turn the product off, and then on again.

Click here to go online for more information.

**Setup Cartridges**

When you first setup the printer, you must install the cartridges that shipped in the box with the printer. These cartridges are labeled SETUP, and they calibrate your printer before the first print job. Failure to install the SETUP cartridges during the initial product setup causes an error. If you installed a set of regular cartridges, remove them and install the SETUP cartridges to complete printer setup. After printer setup is complete, the printer can use regular cartridges.

⚠️ **WARNING!** Don’t open or uncap cartridges until you are ready to install them. Leaving caps on the cartridges reduces ink evaporation. You can use the orange caps from the SETUP cartridges if necessary.
Cartridge Supply Upgrade

Try to get the printer to recognize the supply upgrade cartridge.

1. Remove the supply upgrade cartridge.
2. Insert the original cartridge in the carriage.
3. Close the access door, then wait until the carriage stops moving.
4. Remove the original cartridge, then replace with the supply upgrade cartridge.
5. Close the access door, then wait until the carriage stops moving.

If you still receive a supply upgrade problem error message, contact HP support.

Older Generation Cartridge

You will need to use a newer version of this cartridge. In most cases you can identify a newer version of the cartridge by looking at exterior of the cartridge package and finding the Warranty Ends date.

If it says ‘v1’ several spaces to the right of the date, then the cartridge is the updated newer version.

Networking

- Learn how to find your network security settings. [Click here to go online for more information.]
- Learn about the Network Diagnostic Utility and other troubleshooting tips. [Click here to go online for more information.]
- Learn how to change from a USB to wireless connection. [Click here to go online for more information.]
- Learn how to work with your firewall and anti-virus programs during printer setup. [Click here to go online for more information.]

HP support

- [Register the product]
- [Support process]
- [HP support by phone]
- [Additional warranty options]
Register the product

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product support alerts. If you did not register your printer while installing the software, you can register now at http://www.register.hp.com.

Support process

If you have a problem, follow these steps:
1. Check the documentation that came with the product.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP customers. It is the fastest source for up-to-date product information and expert assistance and includes the following features:
   • Fast access to qualified online support specialists
   • Software and driver updates for the product
   • Valuable product and troubleshooting information for common problems
   • Proactive product updates, support alerts, and HP newsgrams that are available when you register the product
3. Call HP support. Support options and availability vary by product, country/region, and language.

HP support by phone

Phone support options and availability vary by product, country/region, and language.

This section contains the following topics:
• Phone support period
• Placing a call
• Support phone numbers
• After the phone support period

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support. Standard phone company charges apply.

Placing a call

Call HP support while you are in front of the computer and the product. Be prepared to provide the following information:
• Product name (located on the front panel of the product, such as HP Deskjet 3520, HP Deskjet Ink Advantage 3525)
• Product number (located inside the cartridge access door)
• Serial number (located on the back or bottom of the product)
• Messages that appear when the situation occurs
• Answers to these questions:
  ◦ Has this situation happened before?
  ◦ Can you re-create it?
  ◦ Did you add any new hardware or software to your computer at about the time that this situation began?
  ◦ Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?
Support phone numbers
For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for your country/region to learn more about support options.

Additional warranty options
Extended service plans are available for the HP e-All-in-One at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.
10 Technical information

The technical specifications and international regulatory information for the HP e-All-in-One are provided in this section.

For additional specifications, see the printed documentation that came with the HP e-All-in-One.

This section contains the following topics:

- Notice
- Cartridge chip information
- Specifications
- Environmental product stewardship program
- Regulatory notices

Notice

Hewlett-Packard Company notices

The information contained in this document is subject to change without notice.
All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior written permission of Hewlett-Packard, except as allowed under copyright laws. The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
© 2011 Hewlett-Packard Development Company, L.P.
Microsoft, Windows, Windows XP, and Windows Vista are U.S. registered trademarks of Microsoft Corporation.
Windows 7 is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.
Adobe® is a trademark of Adobe Systems Incorporated.

Cartridge chip information

The HP cartridges used with this product contain a memory chip that assists in the operation of the product. In addition, this memory chip collects a limited set of information about the usage of the product, which might include the following: the date when the cartridge was first installed, the date when the cartridge was last used, the number of pages printed using the cartridge, the page coverage, the printing modes used, any printing errors that might have occurred, and the product model. This information helps HP design future products to meet our customers printing needs.

The data collected from the cartridge memory chip does not contain information that can be used to identify a customer or user of the cartridge or their product.

HP collects a sampling of the memory chips from cartridges returned to HP’s free return and recycling program (HP Planet Partners: www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The memory chips from this sampling are read and studied in order to improve future HP products. HP partners who assist in recycling this cartridge might have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the memory chip. If you prefer to not allow access to this information, you can render the chip inoperable. However, after you render the memory chip inoperable, the cartridge cannot be used in an HP product.

If you are concerned about providing this anonymous information, you can make this information inaccessible by turning off the memory chip’s ability to collect the product’s usage information.
To disable the usage information function
1. From the printer display home screen, select Settings.

   **NOTE:** The home screen displays Copy, Scan, and Quick Forms. If you do not see these options press the Back button until you do.

2. From the Settings menu, select Preferences.
3. Select Cartridge Chip Info. You can set the usage information function on or off.

   **NOTE:** You can continue to use the cartridge in the HP product if you turn off the memory chip's ability to collect the product's usage information.

### Specifications

Technical specifications for the HP e-All-in-One are provided in this section. For more product specifications, see the Product Data Sheet at [www.hp.com/support](http://www.hp.com/support).

This section contains the following topics:
- System requirements
- Environmental specifications
- Paper tray input capacity
- Paper tray output capacity
- Paper size
- Paper weights
- Print specifications
- Copy specifications
- Scan specifications
- Print resolution
- Power specifications
- Cartridge yield
- Acoustic information

### System requirements

For information about future operating system releases and support, visit the HP online support Web site at [www.hp.com/support](http://www.hp.com/support).

### Environmental specifications

- **Recommended operating temperature range:** 15 ºC to 32 ºC (59 ºF to 90 ºF)
- **Allowable operating temperature range:** 5 ºC to 40 ºC (41 ºF to 104 ºF)
- **Humidity:** 15% to 80% RH non-condensing; 28 ºC maximum dewpoint
- **Non-operating (Storage) temperature range:** –40 ºC to 60 ºC (–40 ºF to 140 ºF)
- **In the presence of high electromagnetic fields, it is possible the output from the HP e-All-in-One may be slightly distorted**
- **HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due to potential high electromagnetic fields**

### Paper tray input capacity

- **Plain paper sheets (80 g/m² [20lb]):** Up to 50
- **Envelopes:** Up to 5
- **Index cards:** Up to 20
- **Photo paper sheets:** Up to 20

### Paper tray output capacity

- **Plain paper sheets (80 g/m² [20lb]):** Up to 20
- **Envelopes:** Up to 5
Index cards: Up to 10
Photo paper sheets: Up to 10

**Paper size**
For a complete list of supported media sizes, see the printer software.

**Paper weights**
Plain Paper: 64 to 90 g/m² (16 to 24 lb)
Envelopes: 75 to 90 g/m² (20 to 24 lb)
Cards: Up to 200 g/m² (110-lb index maximum)
Photo Paper: Up to 280 g/m² (75 lb)

**Print specifications**
- Print speeds vary according to the complexity of the document
- Method: drop-on-demand thermal inkjet
- Language: PCL3 GUI

**Copy specifications**
- Digital image processing
- Copy speeds vary according to the complexity of the document and model
- Resolution: up to 600 dpi

**Scan specifications**
- Optical Resolution: up to 1200 dpi
- Hardware Resolution: up to 1200 x 2400 dpi
- Enhanced Resolution: up to 2400 x 2400 dpi
- Bitdepth: 24-bit color, 8-bit grayscale (256 levels of gray)
- Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)
- Supported File Types: BMP, JPEG, PNG, TIFF, PDF
- Twain Version: 1.9

**Print resolution**

**Draft mode**
- Color Input/Black Render: 300x300dpi
- Output (Black/Color): Automatic

**Normal mode**
- Color Input/Black Render: 600x300dpi
- Output (Black/Color): Automatic

**Plain-Best mode**
- Color Input/Black Render: 600x600dpi
- Output: 600x1200dpi (Black), Automatic (Color)

**Photo-Best mode**
- Color Input/Black Render: 600x600dpi
- Output (Black/Color): Automatic

**Max DPI mode**
- Color Input/Black Render: 1200x1200dpi
- Output: Automatic (Black), 4800x1200 optimized dpi (Color)

**Power specifications**

CQ191-60017
- Input voltage: 100-240Vac (+/- 10%)
- Input frequency: 50/60 Hz (+/- 3Hz)
Cartridge yield
Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to: www.hp.com/support.

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment Web site at: www.hp.com/hpinfo/globalcitizenship/environment/index.html.

This section contains the following topics:
- Eco-Tips
- Paper use
- Plastics
- Material safety data sheets
- Recycling program
- HP inkjet supplies recycling program
- Power consumption
- Sleep mode
- Disposal of waste equipment by users in private households in the European Union
- Chemical Substances
- Toxic and hazardous substance table (China)
- Restriction of hazardous substance (Ukraine)
- Battery disposal in the Netherlands
- Battery disposal in Taiwan
- California Perchlorate Material Notice
- EU battery directive

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below to help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific features in this product, please visit the HP Eco Solutions web site for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.
Material safety data sheets

Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging products:

![Energy Star Logo](image)

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Sleep mode

- Power usage is reduced while in Sleep mode.
- After initial setup of printer, the printer will enter Sleep mode after five minutes of inactivity.
- The time to Sleep mode cannot be changed.
Disposal of waste equipment by users in private households in the European Union

Chapter 10

Technical information

Chemical Substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/reach.
Toxic and hazardous substance table (China)

<table>
<thead>
<tr>
<th>器件描述</th>
<th>铅</th>
<th>汞</th>
<th>镉</th>
<th>六价铬</th>
<th>多溴联苯</th>
<th>多溴联苯醚</th>
</tr>
</thead>
<tbody>
<tr>
<td>干电池*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>电池</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>铅酸电池*</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>打印复合纸</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>打印墨盒</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>墨粉</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>激光打印机墨盒*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>打印带</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>套接线*</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>电池板*</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>电池板*</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>充电电池*</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>电池带</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

*：指此部件的任何一部分包含这种有毒有害物质，含量低于SJT11363-2006的限制
X：指此部件使用的任何材料中至少有一种包含这种有毒有害物质，含量高于SJT11363-2006的限制

Restriction of hazardous substance (Ukraine)

Технічний регламент щодо обмеження використання небезпечних речовин (Україна)

Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких небезпечних речовин в електричному та електронному обладнанні, затвердженного постановою Кабінету Міністрів України від 3 грудня 2008 № 1057

Battery disposal in the Netherlands

This HP product contains a lithium manganese dioxide battery. Deze batterij bevat een lithium-manganese-dioxide batterij. Deze bevindt zich op de hoofdprintplaat. Wanneer deze batterij leeg is, moet deze volgens de geldende regels worden afgevoerd.

Battery disposal in Taiwan

廃電池請回收

Please recycle waste batteries.

California Perchlorate Material Notice

California Perchlorate Material Notice

Perchlorate material - special handling may apply. See: http://www.dtsc.ca.gov/hazardouswaste/perchlorate/

This product’s real-time clock battery or coin cell battery may contain perchlorate and may require special handling when recycled or disposed of in California.
EU battery directive

This product contains a battery that is used to maintain the integrity of real time clock or product settings and is designed to last the life of the product. Any attempt to service or replace this battery should be performed by a qualified service technician.

European Union Battery Directive

This product contains a battery that is used to maintain the integrity of real time clock or product settings and is designed to last the life of the product. Any attempt to service or replace this battery should be performed by a qualified service technician.

Regulatory notices

The HP e-All-in-One meets product requirements from regulatory agencies in your country/region.

European Union Battery Directive

This product contains a battery that is used to maintain the integrity of real time clock or product settings and is designed to last the life of the product. Any attempt to service or replace this battery should be performed by a qualified service technician.

Regulatory notices

The HP e-All-in-One meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:

- Regulatory model identification number
- FCC statement
- Notice to users in Korea
- VCCI (Class B) compliance statement for users in Japan
- Notice to users in Japan about the power cord
- European Union Regulatory Notice
- Noise emission statement for Germany
- Notice to users in Germany
- Regulatory wireless statements

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is SNPRH-1102. This regulatory number should not be confused with the marketing name (HP Deskjet 3520 e-All-in-One Printer, etc.) or product numbers (CX052A, etc.).

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Notice to users in Korea

이 기기는 가정용(8급)으로 전자파적합등록을 한 기기로서 주 로 가정에서 사용하는 것을 목적으로 하며, 모든 지역에서 사용할 수 있습니다.
VCCI (Class B) compliance statement for users in Japan

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。取扱説明書に従って正しい取り扱いをして下さい。

VCCI-B

Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU Directives:

- Low Voltage Directive 2006/95/EC
- EMC Directive 2004/108/EC
- Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter provided by HP.

If this product has telecommunications functionality, it also complies with the essential requirements of the following EU Directive:

- R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or product family and available (in English only) either within the product documentation or at the following web site: www.hp.com/go/certificates (type the product number in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications products and for EU harmonized telecommunications products, such as Bluetooth® within power class below 10mW.

For EU non-harmonized telecommunications products (If applicable, a 4-digit notified body number is inserted between CE and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA countries:
Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, and United Kingdom.
The telephone connector (not available for all products) is intended for connection to analogue telephone networks.

**Products with wireless LAN devices**
- Some countries may have specific obligations or special requirements about the operation of Wireless LAN networks such as indoor use only or restrictions of the channels available. Please make sure that the country settings of the wireless network are correct.

**France**
- For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For the latest requirements, see [www.arcep.fr](http://www.arcep.fr).

The point of contact for regulatory matters is:
Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY

**Noise emission statement for Germany**

<table>
<thead>
<tr>
<th>Geräuschemission</th>
</tr>
</thead>
<tbody>
<tr>
<td>LpA &lt; 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19</td>
</tr>
</tbody>
</table>

**Notice to users in Germany**

<table>
<thead>
<tr>
<th>GS-Erklärung (Deutschland)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.</td>
</tr>
</tbody>
</table>

**Regulatory wireless statements**

This section contains the following regulatory information pertaining to wireless products:
- Exposure to radio frequency radiation
- Notice to users in Brazil
- Notice to users in Canada
- Notice to users in Taiwan

**Exposure to radio frequency radiation**

⚠️ **Caution**  The radiated output power of this device is far below the FCC radio frequency exposure limits. Nevertheless, the device shall be used in such a manner that the potential for human contact during normal operation is minimized. This product and any attached external antenna, if supported, shall be placed in such a manner to minimize the potential for human contact during normal operation. In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity to the antenna shall not be less than 20 cm (8 inches) during normal operation.
Notice to users in Brazil

**Aviso aos usuários no Brasil**
Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em caráter primário. (Res.ANATEL 282/2001).

Notice to users in Canada

**Notice to users in Canada/Note à l'attention des utilisateurs canadiens**

*For Indoor Use.* This digital apparatus does not exceed the Class B limits for radio noise emissions from the digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications. The internal wireless radio complies with RSS 210 and RSS GEN of Industry Canada.

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

*Utiliser à l'intérieur.* Le présent appareil numérique n'émet pas de bruit radioélectrique dépassant les limites applicables aux appareils numériques de la classe B prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada. Le composant RF interne est conforme à la norme RSS210 et RSS GEN d'Industrie Canada.

Conformément au Règlement d'Industrie Canada, cet émetteur radioélectrique ne peut fonctionner qu'avec une antenne d'un type et d'un gain maximum (ou minimum) approuvé par Industrie Canada. Afin de réduire le brouillage radioélectrique potentiel pour d'autres utilisateurs, le type d’antenne et son gain doivent être choisis de manière à ce que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas celle nécessaire à une communication réussie.

Cet appareil est conforme aux normes RSS exemptes de licence d’Industrie Canada. Son fonctionnement dépend des deux conditions suivantes : (1) cet appareil ne doit pas provoquer d'interférences nuisibles et (2) doit accepter toutes interférences reçues, y compris des interférences pouvant provoquer un fonctionnement non souhaité de l’appareil.

Notice to users in Taiwan

**低功率電波輻射性電機管理辦法**

第十二條
經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自變更頻率、加大功率或變更設計之特性及功能。

第十四條
低功率射頻電機之使用不得影響飛航安全及干擾合法通信；經發現有干擾現象時，應立即停用，並改善至無干擾時方得繼續使用。

禁止合法通信，指放送依法設定之無線電通信、低功率射頻電機設備等合法通信或工業、科學及醫療用電波輻射性電機設備之干擾。
Index

A
after the support period 49

B
buttons, control panel 6

C
control panel
  buttons 6
  features 6
copy
  specifications 53
customer support
  warranty 49

E
environment
  Environmental product stewardship
    program 54
  environmental specifications 52

I
interface card 33, 34

N
network
  interface card 33, 34

P
paper
  recommended types 17
  phone support 48
  phone support period
    period for support 48
  print
    specifications 53

R
recycle
  ink cartridges 55
regulatory notices
  regulatory model identification
    number 59
  wireless statements 61

S
scan
  scan specifications 53
  support process 48
  system requirements 52

T
technical information
  copy specifications 53
  environmental specifications 52
  print specifications 53

W
warranty 49